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Understanding Embedded - FPGAs (Field
Programmable Gate Array)

Embedded - FPGAs, or Field Programmable Gate Arrays,
are advanced integrated circuits that offer unparalleled
flexibility and performance for digital systems. Unlike
traditional fixed-function logic devices, FPGAs can be
programmed and reprogrammed to execute a wide array
of logical operations, enabling customized functionality
tailored to specific applications. This reprogrammability
allows developers to iterate designs quickly and implement
complex functions without the need for custom hardware.

Applications of Embedded - FPGAs

The versatility of Embedded - FPGAs makes them
indispensable in numerous fields. In telecommunications,
FPGAs are used for high-speed data processing and
network infrastructure. In the automotive industry, they
support advanced driver-assistance systems (ADAS) and
infotainment solutions. Consumer electronics benefit from
FPGAs in devices requiring high performance and
adaptability, such as smart TVs and gaming consoles.
Industrial automation relies on FPGAs for real-time control
and processing in machinery and robotics. Additionally,
FPGAs play a crucial role in aerospace and defense, where
their reliability and ability to handle complex algorithms
are essential.

Common Subcategories of Embedded -
FPGAs

Within the realm of Embedded - FPGAs, several
subcategories address different needs and applications.
General-purpose FPGAs are the most widely used, offering
a balance of performance and flexibility for a broad range
of applications. High-performance FPGAs are designed for
applications requiring exceptional speed and
computational power, such as data centers and high-
frequency trading systems. Low-power FPGAs cater to
battery-operated and portable devices where energy
efficiency is paramount. Lastly, automotive-grade FPGAs
meet the stringent standards of the automotive industry,
ensuring reliability and performance in vehicle systems.

Types of Embedded - FPGAs

Embedded - FPGAs can be classified into several types
based on their architecture and specific capabilities. SRAM-
based FPGAs are prevalent due to their high speed and
ability to support complex designs, making them suitable
for performance-critical applications. Flash-based FPGAs
offer non-volatile storage, retaining their configuration
without power and enabling faster start-up times. Antifuse-
based FPGAs provide a permanent, one-time
programmable solution, ensuring robust security and
reliability for critical systems. Each type of FPGA brings
distinct advantages, making the choice dependent on the
specific needs of the application.
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Number of I/O 380

Number of Gates -
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Mounting Type Surface Mount

Operating Temperature 0°C ~ 85°C (TJ)

Package / Case 672-BBGA

Supplier Device Package 672-FPBGA (27x27)
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ROM Mode
ROM mode uses the LUT logic; hence, Slices 0 through 3 can be used in ROM mode. Preloading is accomplished 
through the programming interface during PFU configuration. 

For more information, please refer to TN1179, LatticeECP3 Memory Usage Guide.

Routing 
There are many resources provided in the LatticeECP3 devices to route signals individually or as busses with 
related control signals. The routing resources consist of switching circuitry, buffers and metal interconnect (routing) 
segments. 

The LatticeECP3 family has an enhanced routing architecture that produces a compact design. The Diamond and 
ispLEVER design software tool suites take the output of the synthesis tool and places and routes the design. 

sysCLOCK PLLs and DLLs
The sysCLOCK PLLs provide the ability to synthesize clock frequencies. The devices in the LatticeECP3 family 
support two to ten full-featured General Purpose PLLs.

General Purpose PLL
The architecture of the PLL is shown in Figure 2-4. A description of the PLL functionality follows. 

CLKI is the reference frequency (generated either from the pin or from routing) for the PLL. CLKI feeds into the 
Input Clock Divider block. The CLKFB is the feedback signal (generated from CLKOP, CLKOS or from a user clock 
pin/logic). This signal feeds into the Feedback Divider. The Feedback Divider is used to multiply the reference fre-
quency.

Both the input path and feedback signals enter the Phase Frequency Detect Block (PFD) which detects first for the 
frequency, and then the phase, of the CLKI and CLKFB are the same which then drives the Voltage Controlled 
Oscillator (VCO) block. In this block the difference between the input path and feedback signals is used to control 
the frequency and phase of the oscillator. A LOCK signal is generated by the VCO to indicate that the VCO has 
locked onto the input clock signal. In dynamic mode, the PLL may lose lock after a dynamic delay adjustment and 
not relock until the tLOCK parameter has been satisfied.

The output of the VCO then enters the CLKOP divider. The CLKOP divider allows the VCO to operate at higher fre-
quencies than the clock output (CLKOP), thereby increasing the frequency range. The Phase/Duty Cycle/Duty Trim 
block adjusts the phase and duty cycle of the CLKOS signal. The phase/duty cycle setting can be pre-programmed 
or dynamically adjusted. A secondary divider takes the CLKOP or CLKOS signal and uses it to derive lower fre-
quency outputs (CLKOK).

The primary output from the CLKOP divider (CLKOP) along with the outputs from the secondary dividers (CLKOK 
and CLKOK2) and Phase/Duty select (CLKOS) are fed to the clock distribution network.

The PLL allows two methods for adjusting the phase of signal. The first is referred to as Fine Delay Adjustment. 
This inserts up to 16 nominal 125 ps delays to be applied to the secondary PLL output. The number of steps may 
be set statically or from the FPGA logic. The second method is referred to as Coarse Phase Adjustment. This 
allows the phase of the rising and falling edge of the secondary PLL output to be adjusted in 22.5 degree steps. 
The number of steps may be set statically or from the FPGA logic.

www.latticesemi.com/dynamic/view_document.cfm?document_id=32319
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Figure 2-20. Sources of Edge Clock (Left and Right Edges)

Figure 2-21. Sources of Edge Clock (Top Edge)

The edge clocks have low injection delay and low skew. They are used to clock the I/O registers and thus are ideal 
for creating I/O interfaces with a single clock signal and a wide data bus. They are also used for DDR Memory or 
Generic DDR interfaces.
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Figure 2-31. MULTADDSUBSUM Slice 1

Advanced sysDSP Slice Features
Cascading
The LatticeECP3 sysDSP slice has been enhanced to allow cascading. Adder trees are implemented fully in sys-
DSP slices, improving the performance. Cascading of slices uses the signals CIN, COUT and C Mux of the slice.

Addition
The LatticeECP3 sysDSP slice allows for the bypassing of multipliers and cascading of adder logic. High perfor-
mance adder functions are implemented without the use of LUTs. The maximum width adders that can be imple-
mented are 54-bit.

Rounding
The rounding operation is implemented in the ALU and is done by adding a constant followed by a truncation oper-
ation. The rounding methods supported are:

• Rounding to zero (RTZ)

• Rounding to infinity (RTI)

• Dynamic rounding

• Random rounding

• Convergent rounding 
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Please see TN1177, LatticeECP3 sysIO Usage Guide for on-chip termination usage and value ranges.

Equalization Filter
Equalization filtering is available for single-ended inputs on both true and complementary I/Os, and for differential 
inputs on the true I/Os on the left, right, and top sides. Equalization is required to compensate for the difficulty of 
sampling alternating logic transitions with a relatively slow slew rate. It is considered the most useful for the Input 
DDRX2 modes, used in DDR3 memory, LVDS, or TRLVDS signaling. Equalization filter acts as a tunable filter with 
settings to determine the level of correction. In the LatticeECP3 devices, there are four settings available: 0 (none), 
1, 2 and 3. The default setting is 0. The equalization logic resides in the sysI/O buffers, the two bits of setting is set 
uniquely in each input IOLOGIC block. Therefore, each sysI/O can have a unique equalization setting within a 
DQS-12 group.

Hot Socketing
LatticeECP3 devices have been carefully designed to ensure predictable behavior during power-up and power-
down. During power-up and power-down sequences, the I/Os remain in tri-state until the power supply voltage is 
high enough to ensure reliable operation. In addition, leakage into I/O pins is controlled within specified limits. 
Please refer to the Hot Socketing Specifications in the DC and Switching Characteristics in this data sheet.

SERDES and PCS (Physical Coding Sublayer)
LatticeECP3 devices feature up to 16 channels of embedded SERDES/PCS arranged in quads at the bottom of the 
devices supporting up to 3.2Gbps data rate. Figure 2-40 shows the position of the quad blocks for the LatticeECP3-
150 devices. Table 2-14 shows the location of available SERDES Quads for all devices.

The LatticeECP3 SERDES/PCS supports a range of popular serial protocols, including:

• PCI Express 1.1

• Ethernet (XAUI, GbE - 1000 Base CS/SX/LX and SGMII)

• Serial RapidIO

• SMPTE SDI (3G, HD, SD)

• CPRI

• SONET/SDH (STS-3, STS-12, STS-48)

Each quad contains four dedicated SERDES for high speed, full duplex serial data transfer. Each quad also has a 
PCS block that interfaces to the SERDES channels and contains protocol specific digital logic to support the stan-
dards listed above. The PCS block also contains interface logic to the FPGA fabric. All PCS logic for dedicated pro-
tocol support can also be bypassed to allow raw 8-bit or 10-bit interfaces to the FPGA fabric.

Even though the SERDES/PCS blocks are arranged in quads, multiple baud rates can be supported within a quad 
with the use of dedicated, per channel 1, 2 and 11 rate dividers. Additionally, multiple quads can be arranged 
together to form larger data pipes.

For information on how to use the SERDES/PCS blocks to support specific protocols, as well on how to combine 
multiple protocols and baud rates within a device, please refer to TN1176, LatticeECP3 SERDES/PCS Usage 
Guide.

www.latticesemi.com/dynamic/view_document.cfm?document_id=32317
www.latticesemi.com/dynamic/view_document.cfm?document_id=32316
www.latticesemi.com/dynamic/view_document.cfm?document_id=32316
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SCI (SERDES Client Interface) Bus
The SERDES Client Interface (SCI) is an IP interface that allows the SERDES/PCS Quad block to be controlled by 
registers rather than the configuration memory cells. It is a simple register configuration interface that allows 
SERDES/PCS configuration without power cycling the device.

The Diamond and ispLEVER design tools support all modes of the PCS. Most modes are dedicated to applications 
associated with a specific industry standard data protocol. Other more general purpose modes allow users to 
define their own operation. With these tools, the user can define the mode for each quad in a design. 

Popular standards such as 10Gb Ethernet, x4 PCI Express and 4x Serial RapidIO can be implemented using IP 
(available through Lattice), a single quad (Four SERDES channels and PCS) and some additional logic from the 
core. 

The LatticeECP3 family also supports a wide range of primary and secondary protocols. Within the same quad, the 
LatticeECP3 family can support mixed protocols with semi-independent clocking as long as the required clock fre-
quencies are integer x1, x2, or x11 multiples of each other. Table 2-15 lists the allowable combination of primary 
and secondary protocol combinations. 

Flexible Quad SERDES Architecture
The LatticeECP3 family SERDES architecture is a quad-based architecture. For most SERDES settings and stan-
dards, the whole quad (consisting of four SERDES) is treated as a unit. This helps in silicon area savings, better 
utilization and overall lower cost.

However, for some specific standards, the LatticeECP3 quad architecture provides flexibility; more than one stan-
dard can be supported within the same quad.

Table 2-15 shows the standards can be mixed and matched within the same quad. In general, the SERDES stan-
dards whose nominal data rates are either the same or a defined subset of each other, can be supported within the 
same quad. In Table 2-15, the Primary Protocol column refers to the standard that determines the reference clock 
and PLL settings. The Secondary Protocol column shows the other standard that can be supported within the 
same quad.

Furthermore, Table 2-15 also implies that more than two standards in the same quad can be supported, as long as 
they conform to the data rate and reference clock requirements. For example, a quad may contain PCI Express 1.1, 
SGMII, Serial RapidIO Type I and Serial RapidIO Type II, all in the same quad.

Table 2-15. LatticeECP3 Primary and Secondary Protocol Support

Primary Protocol Secondary Protocol

PCI Express 1.1 SGMII

PCI Express 1.1 Gigabit Ethernet

PCI Express 1.1 Serial RapidIO Type I

PCI Express 1.1 Serial RapidIO Type II

Serial RapidIO Type I SGMII

Serial RapidIO Type I Gigabit Ethernet

Serial RapidIO Type II SGMII

Serial RapidIO Type II Gigabit Ethernet

Serial RapidIO Type II Serial RapidIO Type I

CPRI-3 CPRI-2 and CPRI-1

3G-SDI HD-SDI and SD-SDI
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There are some restrictions to be aware of when using spread spectrum. When a quad shares a PCI Express x1 
channel with a non-PCI Express channel, ensure that the reference clock for the quad is compatible with all proto-
cols within the quad. For example, a PCI Express spread spectrum reference clock is not compatible with most 
Gigabit Ethernet applications because of tight CTC ppm requirements.

While the LatticeECP3 architecture will allow the mixing of a PCI Express channel and a Gigabit Ethernet, Serial 
RapidIO or SGMII channel within the same quad, using a PCI Express spread spectrum clocking as the transmit 
reference clock will cause a violation of the Gigabit Ethernet, Serial RapidIO and SGMII transmit jitter specifica-
tions.

For further information on SERDES, please see TN1176, LatticeECP3 SERDES/PCS Usage Guide.

IEEE 1149.1-Compliant Boundary Scan Testability 
All LatticeECP3 devices have boundary scan cells that are accessed through an IEEE 1149.1 compliant Test 
Access Port (TAP). This allows functional testing of the circuit board on which the device is mounted through a 
serial scan path that can access all critical logic nodes. Internal registers are linked internally, allowing test data to 
be shifted in and loaded directly onto test nodes, or test data to be captured and shifted out for verification. The test 
access port consists of dedicated I/Os: TDI, TDO, TCK and TMS. The test access port has its own supply voltage 
VCCJ and can operate with LVCMOS3.3, 2.5, 1.8, 1.5 and 1.2 standards. 

For more information, please see TN1169, LatticeECP3 sysCONFIG Usage Guide.

Device Configuration 
All LatticeECP3 devices contain two ports that can be used for device configuration. The Test Access Port (TAP), 
which supports bit-wide configuration, and the sysCONFIG port, support dual-byte, byte and serial configuration. 
The TAP supports both the IEEE Standard 1149.1 Boundary Scan specification and the IEEE Standard 1532 In- 
System Configuration specification. The sysCONFIG port includes seven I/Os used as dedicated pins with the 
remaining pins used as dual-use pins. See TN1169, LatticeECP3 sysCONFIG Usage Guide for more information 
about using the dual-use pins as general purpose I/Os.

There are various ways to configure a LatticeECP3 device:

1. JTAG

2. Standard Serial Peripheral Interface (SPI and SPIm modes) - interface to boot PROM memory

3. System microprocessor to drive a x8 CPU port (PCM mode)

4. System microprocessor to drive a serial slave SPI port (SSPI mode)

5. Generic byte wide flash with a MachXO™ device, providing control and addressing

On power-up, the FPGA SRAM is ready to be configured using the selected sysCONFIG port. Once a configuration 
port is selected, it will remain active throughout that configuration cycle. The IEEE 1149.1 port can be activated any 
time after power-up by sending the appropriate command through the TAP port. 

LatticeECP3 devices also support the Slave SPI Interface. In this mode, the FPGA behaves like a SPI Flash device 
(slave mode) with the SPI port of the FPGA to perform read-write operations.

www.latticesemi.com/dynamic/view_document.cfm?document_id=32316
www.latticesemi.com/dynamic/view_document.cfm?document_id=32314
www.latticesemi.com/dynamic/view_document.cfm?document_id=32314
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LatticeECP3 Supply Current (Standby)1, 2, 3, 4, 5, 6

Over Recommended Operating Conditions

Symbol Parameter Device

Typical

Units–6L, –7L, –8L –6, –7, –8

ICC Core Power Supply Current

ECP-17EA 29.8 49.4 mA

ECP3-35EA 53.7 89.4 mA

ECP3-70EA 137.3 230.7 mA

ECP3-95EA 137.3 230.7 mA

ECP3-150EA 219.5 370.9 mA

ICCAUX Auxiliary Power Supply Current

ECP-17EA 18.3 19.4 mA

ECP3-35EA 19.6 23.1 mA

ECP3-70EA 26.5 32.4 mA

ECP3-95EA 26.5 32.4 mA

ECP3-150EA 37.0 45.7 mA

ICCPLL PLL Power Supply Current (Per PLL)

ECP-17EA 0.0 0.0 mA

ECP3-35EA 0.1 0.1 mA

ECP3-70EA 0.1 0.1 mA

ECP3-95EA 0.1 0.1 mA

ECP3-150EA 0.1 0.1 mA

ICCIO Bank Power Supply Current (Per Bank)

ECP-17EA 1.3 1.4 mA

ECP3-35EA 1.3 1.4 mA

ECP3-70EA 1.4 1.5 mA

ECP3-95EA 1.4 1.5 mA

ECP3-150EA 1.4 1.5 mA

ICCJ JTAG Power Supply Current All Devices 2.5 2.5 mA

ICCA
Transmit, Receive, PLL and 
Reference Clock Buffer Power Supply

ECP-17EA 6.1 6.1 mA

ECP3-35EA 6.1 6.1 mA

ECP3-70EA 18.3 18.3 mA

ECP3-95EA 18.3 18.3 mA

ECP3-150EA 24.4 24.4 mA

1. For further information on supply current, please see the list of technical documentation at the end of this data sheet.
2. Assumes all outputs are tristated, all inputs are configured as LVCMOS and held at the VCCIO or GND.
3. Frequency 0 MHz.
4. Pattern represents a “blank” configuration data file.
5. TJ = 85 °C, power supplies at nominal voltage.
6. To determine the LatticeECP3 peak start-up current data, use the Power Calculator tool.
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MLVDS25
The LatticeECP3 devices support the differential MLVDS standard. This standard is emulated using complemen-
tary LVCMOS outputs in conjunction with a parallel resistor across the driver outputs. The MLVDS input standard is 
supported by the LVDS differential input buffer. The scheme shown in Figure 3-5 is one possible solution for 
MLVDS standard implementation. Resistor values in Figure 3-5 are industry standard values for 1% resistors. 

Figure 3-5. MLVDS25 (Multipoint Low Voltage Differential Signaling)

Table 3-5. MLVDS25 DC Conditions1 

Parameter Description

Typical

UnitsZo=50 Zo=70

VCCIO Output Driver Supply (+/–5%) 2.50 2.50 V

ZOUT Driver Impedance 10.00 10.00 

RS Driver Series Resistor (+/–1%) 35.00 35.00 

RTL Driver Parallel Resistor (+/–1%) 50.00 70.00 

RTR Receiver Termination (+/–1%) 50.00 70.00 

VOH Output High Voltage 1.52 1.60 V

VOL Output Low Voltage 0.98 0.90 V

VOD Output Differential Voltage 0.54 0.70 V

VCM Output Common Mode Voltage 1.25 1.25 V

IDC DC Output Current 21.74 20.00 mA

1. For input buffer, see LVDS table.
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Figure 3-6. Generic DDRX1/DDRX2 (With Clock and Data Edges Aligned)

Figure 3-7. DDR/DDR2/DDR3 Parameters
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LVCMOS15_4mA LVCMOS 1.5 4 mA drive, fast slew rate 0.21 0.25 0.29 ns

LVCMOS15_8mA LVCMOS 1.5 8 mA drive, fast slew rate 0.05 0.07 0.09 ns

LVCMOS12_2mA LVCMOS 1.2 2 mA drive, fast slew rate 0.43 0.51 0.59 ns

LVCMOS12_6mA LVCMOS 1.2 6 mA drive, fast slew rate 0.23 0.28 0.33 ns

LVCMOS33_4mA LVCMOS 3.3 4 mA drive, slow slew rate 1.44 1.58 1.72 ns

LVCMOS33_8mA LVCMOS 3.3 8 mA drive, slow slew rate 0.98 1.10 1.22 ns

LVCMOS33_12mA LVCMOS 3.3 12 mA drive, slow slew rate 0.67 0.77 0.86 ns

LVCMOS33_16mA LVCMOS 3.3 16 mA drive, slow slew rate 0.97 1.09 1.21 ns

LVCMOS33_20mA LVCMOS 3.3 20 mA drive, slow slew rate 0.67 0.76 0.85 ns

LVCMOS25_4mA LVCMOS 2.5 4 mA drive, slow slew rate 1.48 1.63 1.78 ns

LVCMOS25_8mA LVCMOS 2.5 8 mA drive, slow slew rate 1.02 1.14 1.27 ns

LVCMOS25_12mA LVCMOS 2.5 12 mA drive, slow slew rate 0.74 0.84 0.94 ns

LVCMOS25_16mA LVCMOS 2.5 16 mA drive, slow slew rate 1.02 1.14 1.26 ns

LVCMOS25_20mA LVCMOS 2.5 20 mA drive, slow slew rate 0.74 0.83 0.93 ns

LVCMOS18_4mA LVCMOS 1.8 4 mA drive, slow slew rate 1.60 1.77 1.93 ns

LVCMOS18_8mA LVCMOS 1.8 8 mA drive, slow slew rate 1.11 1.25 1.38 ns

LVCMOS18_12mA LVCMOS 1.8 12 mA drive, slow slew rate 0.87 0.98 1.09 ns

LVCMOS18_16mA LVCMOS 1.8 16 mA drive, slow slew rate 0.86 0.97 1.07 ns

LVCMOS15_4mA LVCMOS 1.5 4 mA drive, slow slew rate 1.71 1.89 2.08 ns

LVCMOS15_8mA LVCMOS 1.5 8 mA drive, slow slew rate 1.20 1.34 1.48 ns

LVCMOS12_2mA LVCMOS 1.2 2 mA drive, slow slew rate 1.37 1.56 1.74 ns

LVCMOS12_6mA LVCMOS 1.2 6 mA drive, slow slew rate 1.11 1.27 1.43 ns

PCI33 PCI, VCCIO = 3.3 V –0.12 –0.13 –0.14 ns

1. Timing adders are characterized but not tested on every device.
2. LVCMOS timing measured with the load specified in Switching Test Condition table.
3. All other standards tested according to the appropriate specifications. 
4. Not all I/O standards and drive strengths are supported for all banks. See the Architecture section of this data sheet for details.
5. Commercial timing numbers are shown. Industrial numbers are typically slower and can be extracted from the Diamond or ispLEVER soft-

ware.
6. This data does not apply to the LatticeECP3-17EA device.
7. For details on –9 speed grade devices, please contact your Lattice Sales Representative.

LatticeECP3 Family Timing Adders1, 2, 3, 4, 5, 7 (Continued)
Over Recommended Commercial Operating Conditions

Buffer Type Description –8 –7 –6 Units
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DLL Timing
Over Recommended Operating Conditions

Parameter Description Condition Min. Typ. Max. Units 

fREF 
Input reference clock frequency (on-chip or 
off-chip)  133 — 500 MHz 

fFB Feedback clock frequency (on-chip or off-chip)  133 — 500 MHz 

fCLKOP
1 Output clock frequency, CLKOP  133 — 500 MHz 

fCLKOS
2 Output clock frequency, CLKOS  33.3 — 500 MHz 

tPJIT Output clock period jitter (clean input)   — 200 ps p-p 

tDUTY 

Output clock duty cycle (at 50% levels, 50% duty 
cycle input clock, 50% duty cycle circuit turned 
off, time reference delay mode) 

Edge Clock 40  60 % 

Primary Clock 30  70 % 

tDUTYTRD 

Output clock duty cycle (at 50% levels, arbitrary 
duty cycle input clock, 50% duty cycle circuit 
enabled, time reference delay mode) 

Primary Clock < 250 MHz 45  55 % 

Primary Clock 250 MHz 30  70 % 

Edge Clock 45  55 % 

tDUTYCIR 

Output clock duty cycle (at 50% levels, arbitrary 
duty cycle input clock, 50% duty cycle circuit 
enabled, clock injection removal mode) with DLL 
cascading

Primary Clock < 250 MHz 40  60 % 

Primary Clock  250 MHz 30  70 % 

Edge Clock 45  55 % 

tSKEW
3 Output clock to clock skew between two outputs 

with the same phase setting  — — 100 ps 

tPHASE 
Phase error measured at device pads between 
off-chip reference clock and feedback clocks  — — +/-400 ps 

tPWH 
Input clock minimum pulse width high (at 80% 
level)  550 — — ps 

tPWL Input clock minimum pulse width low (at 20% 
level)  550 — — ps 

tINSTB Input clock period jitter  — — 500 ps

tLOCK DLL lock time  8 — 8200 cycles 

tRSWD Digital reset minimum pulse width (at 80% level)  3 — — ns 

tDEL Delay step size  27 45 70 ps 

tRANGE1 
Max. delay setting for single delay block 
(64 taps)  1.9 3.1 4.4 ns 

tRANGE4 Max. delay setting for four chained delay blocks  7.6 12.4 17.6 ns 

1. CLKOP runs at the same frequency as the input clock.
2. CLKOS minimum frequency is obtained with divide by 4.
3. This is intended to be a “path-matching” design guideline and is not a measurable specification.
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SERDES External Reference Clock 
The external reference clock selection and its interface are a critical part of system applications for this product. 
Table 3-12 specifies reference clock requirements, over the full range of operating conditions.

Figure 3-13. SERDES External Reference Clock Waveforms

Table 3-12. External Reference Clock Specification (refclkp/refclkn) 

Symbol Description Min. Typ. Max. Units

FREF Frequency range 15 — 320 MHz 

FREF-PPM Frequency tolerance1 –1000 — 1000 ppm

VREF-IN-SE Input swing, single-ended clock2 200 — VCCA mV, p-p

VREF-IN-DIFF Input swing, differential clock 200 — 2*VCCA
mV, p-p 

differential

VREF-IN Input levels 0 — VCCA + 0.3 V

DREF Duty cycle3 40 — 60 %

TREF-R Rise time (20% to 80%) 200 500 1000 ps

TREF-F Fall time (80% to 20%) 200 500 1000 ps

ZREF-IN-TERM-DIFF Differential input termination –20% 100/2K +20% Ohms

CREF-IN-CAP Input capacitance — — 7 pF

1. Depending on the application, the PLL_LOL_SET and CDR_LOL_SET control registers may be adjusted for other tolerance values as 
described in TN1176, LatticeECP3 SERDES/PCS Usage Guide.

2. The signal swing for a single-ended input clock must be as large as the p-p differential swing of a differential input clock to get the same gain 
at the input receiver. Lower swings for the clock may be possible, but will tend to increase jitter.

3. Measured at 50% amplitude.

VREF_IN_DIFF
Min=200 mV

Max=2xVCCA

VREF_IN_DIFF=
IVp-VnI

VREF_IN_SE
Min=200 mV
Max=VCCA

VREF-IN
MAX < 1.56 V

VREF-IN
MAX < 1.56 V

www.latticesemi.com/dynamic/view_document.cfm?document_id=32316
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Figure 3-16. Jitter Transfer – 1.25 Gbps

Figure 3-17. Jitter Transfer – 622 Mbps
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SMPTE SD/HD-SDI/3G-SDI (Serial Digital Interface) Electrical and Timing 
Characteristics
AC and DC Characteristics
Table 3-19. Transmit

Table 3-20. Receive

Table 3-21. Reference Clock

Symbol Description Test Conditions Min. Typ. Max. Units

BRSDO Serial data rate 270 — 2975 Mbps

TJALIGNMENT
 2 Serial output jitter, alignment 270 Mbps — — 0.20 UI

TJALIGNMENT
 2 Serial output jitter, alignment 1485 Mbps — — 0.20 UI

TJALIGNMENT
1, 2 Serial output jitter, alignment 2970Mbps — — 0.30 UI

TJTIMING Serial output jitter, timing 270 Mbps — — 0.20 UI

TJTIMING Serial output jitter, timing 1485 Mbps — — 1.0 UI

TJTIMING Serial output jitter, timing 2970 Mbps — — 2.0 UI

Notes:
1. Timing jitter is measured in accordance with SMPTE RP 184-1996, SMPTE RP 192-1996 and the applicable serial data transmission stan-

dard, SMPTE 259M-1997 or SMPTE 292M (proposed). A color bar test pattern is used.The value of fSCLK is 270 MHz or 360 MHz for 
SMPTE 259M, 540 MHz for SMPTE 344M or 1485 MHz for SMPTE 292M serial data rates. See the Timing Jitter Bandpass section.

2. Jitter is defined in accordance with SMPTE RP1 184-1996 as: jitter at an equipment output in the absence of input jitter.
3. All Tx jitter is measured at the output of an industry standard cable driver; connection to the cable driver is via a 50 Ohm impedance differ-

ential signal from the Lattice SERDES device.
4. The cable driver drives: RL=75 Ohm, AC-coupled at 270, 1485, or 2970 Mbps, RREFLVL=RREFPRE=4.75 kOhm 1%.

Symbol Description Test Conditions Min. Typ. Max. Units

BRSDI Serial input data rate 270 — 2970 Mbps

CID Stream of non-transitions 
(=Consecutive Identical Digits)

7(3G)/26(SMPTE 
Triple rates) 

@ 10-12 BER
— — Bits

Symbol Description Test Conditions Min. Typ. Max. Units

FVCLK Video output clock frequency 27 — 74.25 MHz

DCV Duty cycle, video clock 45 50 55 %
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JTAG Port Timing Specifications
Over Recommended Operating Conditions

Figure 3-32. JTAG Port Timing Waveforms

Symbol Parameter Min Max Units

fMAX TCK clock frequency — 25 MHz

tBTCP TCK [BSCAN] clock pulse width 40 — ns

tBTCPH TCK [BSCAN] clock pulse width high 20 — ns

tBTCPL TCK [BSCAN] clock pulse width low 20 — ns

tBTS TCK [BSCAN] setup time 10 — ns

tBTH TCK [BSCAN] hold time 8 — ns

tBTRF TCK [BSCAN] rise/fall time 50 — mV/ns

tBTCO TAP controller falling edge of clock to valid output — 10 ns

tBTCODIS TAP controller falling edge of clock to valid disable — 10 ns

tBTCOEN TAP controller falling edge of clock to valid enable — 10 ns

tBTCRS BSCAN test capture register setup time 8 — ns

tBTCRH BSCAN test capture register hold time 25 — ns

tBUTCO BSCAN test update register, falling edge of clock to valid output — 25 ns

tBTUODIS BSCAN test update register, falling edge of clock to valid disable — 25 ns

tBTUPOEN BSCAN test update register, falling edge of clock to valid enable — 25 ns

TMS

TDI

TCK

TDO

Data to be
captured
from I/O

Data to be
driven out

to I/O

ataD dilaVataD dilaV

ataD dilaVataD dilaV

Data Captured

tBTCPH tBTCPL

tBTCOEN

tBTCRS

tBTUPOEN tBUTCO tBTUODIS

tBTCRH

tBTCO tBTCODIS

tBTS tBTH

tBTCP
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D7/SPID0 I/O Parallel configuration I/O. SPI/SPIm data input. Open drain during configura-
tion.

DI/CSSPI0N/CEN I/O Serial data input for slave serial mode. SPI/SPIm mode chip select. 

Dedicated SERDES Signals3

PCS[Index]_HDINNm I High-speed input, negative channel m 

PCS[Index]_HDOUTNm O High-speed output, negative channel m 

PCS[Index]_REFCLKN I Negative Reference Clock Input 

PCS[Index]_HDINPm I High-speed input, positive channel m 

PCS[Index]_HDOUTPm O High-speed output, positive channel m 

PCS[Index]_REFCLKP I Positive Reference Clock Input 

PCS[Index]_VCCOBm — Output buffer power supply, channel m (1.2V/1.5)

PCS[Index]_VCCIBm — Input buffer power supply, channel m (1.2V/1.5V) 

1. When placing switching I/Os around these critical pins that are designed to supply the device with the proper reference or supply voltage, 
care must be given. 

2. These pins are dedicated inputs or can be used as general purpose I/O.
3. m defines the associated channel in the quad. 

Signal Descriptions (Cont.)
Signal Name I/O Description 
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PICs and DDR Data (DQ) Pins Associated with the DDR Strobe (DQS) Pin
PICs Associated with 

DQS Strobe PIO Within PIC
DDR Strobe (DQS) and 

Data (DQ) Pins

For Left and Right Edges of the Device

P[Edge] [n-3] 
A DQ 

B DQ 

P[Edge] [n-2] 
A DQ 

B DQ 

P[Edge] [n-1] 
A DQ

B DQ 

P[Edge] [n] 
A [Edge]DQSn

B DQ 

P[Edge] [n+1] 
A DQ 

B DQ 

P[Edge] [n+2] 
A DQ 

B DQ 

For Top Edge of the Device

P[Edge] [n-3] 
A DQ 

B DQ 

P[Edge] [n-2] 
A DQ 

B DQ 

P[Edge] [n-1] 
A DQ 

B DQ 

P[Edge] [n] 
A [Edge]DQSn 

B DQ 

P[Edge] [n+1] 
A DQ 

B DQ 

P[Edge] [n+2] 
A DQ 

B DQ 

Note: “n” is a row PIC number. 
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Package Pinout Information
Package pinout information can be found under “Data Sheets” on the LatticeECP3 product pages on the Lattice 
website at http://www.latticesemi.com/Products/FPGAandCPLD/LatticeECP3 and in the Diamond or ispLEVER 
software tools. To create pinout information from within ispLEVER Design Planner, select Tools > Spreadsheet 
View. Then select Select File > Export and choose a type of output file. To create a pin information file from within 
Diamond select Tools > Spreadsheet View or Tools >Package View; then, select File > Export and choose a 
type of output file. See Diamond or ispLEVER Help for more information.

Thermal Management 
Thermal management is recommended as part of any sound FPGA design methodology. To assess the thermal 
characteristics of a system, Lattice specifies a maximum allowable junction temperature in all device data sheets. 
Designers must complete a thermal analysis of their specific design to ensure that the device and package do not 
exceed the junction temperature limits. Refer to the Thermal Management document to find the device/package 
specific thermal values.

For Further Information
For further information regarding Thermal Management, refer to the following:

• Thermal Management document

• TN1181, Power Consumption and Management for LatticeECP3 Devices

• Power Calculator tool included with the Diamond and ispLEVER design tools, or as a standalone download from 
www.latticesemi.com/software

http://www.latticesemi.com/Products/FPGAandCPLD/LatticeECP3.aspx
www.latticesemi.com/dynamic/view_document.cfm?document_id=210
www.latticesemi.com/dynamic/view_document.cfm?document_id=32321
http://www.latticesemi.com/products/designsoftware/index.cfm
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Part Number Voltage Grade1 Power Package Pins Temp. LUTs (K) 

LFE3-70EA-6FN484I 1.2 V –6 STD Lead-Free fpBGA 484 IND 67

LFE3-70EA-7FN484I 1.2 V –7 STD Lead-Free fpBGA 484 IND 67

LFE3-70EA-8FN484I 1.2 V –8 STD Lead-Free fpBGA 484 IND 67

LFE3-70EA-6LFN484I 1.2 V –6 LOW Lead-Free fpBGA 484 IND 67

LFE3-70EA-7LFN484I 1.2 V –7 LOW Lead-Free fpBGA 484 IND 67

LFE3-70EA-8LFN484I 1.2 V –8 LOW Lead-Free fpBGA 484 IND 67

LFE3-70EA-6FN672I 1.2 V –6 STD Lead-Free fpBGA 672 IND 67

LFE3-70EA-7FN672I 1.2 V –7 STD Lead-Free fpBGA 672 IND 67

LFE3-70EA-8FN672I 1.2 V –8 STD Lead-Free fpBGA 672 IND 67

LFE3-70EA-6LFN672I 1.2 V –6 LOW Lead-Free fpBGA 672 IND 67

LFE3-70EA-7LFN672I 1.2 V –7 LOW Lead-Free fpBGA 672 IND 67

LFE3-70EA-8LFN672I 1.2 V –8 LOW Lead-Free fpBGA 672 IND 67

LFE3-70EA-6FN1156I 1.2 V –6 STD Lead-Free fpBGA 1156 IND 67

LFE3-70EA-7FN1156I 1.2 V –7 STD Lead-Free fpBGA 1156 IND 67

LFE3-70EA-8FN1156I 1.2 V –8 STD Lead-Free fpBGA 1156 IND 67

LFE3-70EA-6LFN1156I 1.2 V –6 LOW Lead-Free fpBGA 1156 IND 67

LFE3-70EA-7LFN1156I 1.2 V –7 LOW Lead-Free fpBGA 1156 IND 67

LFE3-70EA-8LFN1156I 1.2 V –8 LOW Lead-Free fpBGA 1156 IND 67

1. For ordering information on -9 speed grade devices, please contact your Lattice Sales Representative.

Part Number Voltage Grade1 Power Package Pins Temp. LUTs (K) 

LFE3-95EA-6FN484I 1.2 V –6 STD Lead-Free fpBGA 484 IND 92

LFE3-95EA-7FN484I 1.2 V –7 STD Lead-Free fpBGA 484 IND 92

LFE3-95EA-8FN484I 1.2 V –8 STD Lead-Free fpBGA 484 IND 92

LFE3-95EA-6LFN484I 1.2 V –6 LOW Lead-Free fpBGA 484 IND 92

LFE3-95EA-7LFN484I 1.2 V –7 LOW Lead-Free fpBGA 484 IND 92

LFE3-95EA-8LFN484I 1.2 V –8 LOW Lead-Free fpBGA 484 IND 92

LFE3-95EA-6FN672I 1.2 V –6 STD Lead-Free fpBGA 672 IND 92

LFE3-95EA-7FN672I 1.2 V –7 STD Lead-Free fpBGA 672 IND 92

LFE3-95EA-8FN672I 1.2 V –8 STD Lead-Free fpBGA 672 IND 92

LFE3-95EA-6LFN672I 1.2 V –6 LOW Lead-Free fpBGA 672 IND 92

LFE3-95EA-7LFN672I 1.2 V –7 LOW Lead-Free fpBGA 672 IND 92

LFE3-95EA-8LFN672I 1.2 V –8 LOW Lead-Free fpBGA 672 IND 92

LFE3-95EA-6FN1156I 1.2 V –6 STD Lead-Free fpBGA 1156 IND 92

LFE3-95EA-7FN1156I 1.2 V –7 STD Lead-Free fpBGA 1156 IND 92

LFE3-95EA-8FN1156I 1.2 V –8 STD Lead-Free fpBGA 1156 IND 92

LFE3-95EA-6LFN1156I 1.2 V –6 LOW Lead-Free fpBGA 1156 IND 92

LFE3-95EA-7LFN1156I 1.2 V –7 LOW Lead-Free fpBGA 1156 IND 92

LFE3-95EA-8LFN1156I 1.2 V –8 LOW Lead-Free fpBGA 1156 IND 92

1. For ordering information on -9 speed grade devices, please contact your Lattice Sales Representative.
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Updated Simplified Channel Block Diagram for SERDES/PCS Block 
diagram.

Updated Device Configuration text section.

Corrected software default value of MCCLK to be 2.5 MHz.

DC and Switching 
Characteristics

Updated VCCOB Min/Max data in Recommended Operating Conditions 
table.

Corrected footnote 2 in sysIO Recommended Operating Conditions 
table.

Added added footnote 7 for tSKEW_PRIB to External Switching Charac-
teristics table. 

Added 2-to-1 Gearing text section and table.

Updated External Reference Clock Specification (refclkp/refclkn) table.

LatticeECP3 sysCONFIG Port Timing Specifications - updated tDINIT 
information.

Added sysCONFIG Port Timing waveform.

Serial Input Data Specifications table, delete Typ data for VRX-DIFF-S.

Added footnote 4 to sysCLOCK PLL Timing table for tPFD.

Added SERDES/PCS Block Latency Breakdown table.

External Reference Clock Specifications table, added footnote 4, add 
symbol name vREF-IN-DIFF.

Added SERDES External Reference Clock Waveforms.

Updated Serial Output Timing and Levels table.

Pin-to-pin performance table, changed "typically 3% slower" to "typically 
slower".

Updated timing information

Updated SERDES minimum frequency.

Added data to the following tables: External Switching Characteristics, 
Internal Switching Characteristics, Family Timing Adders, Maximum I/O 
Buffer Speed, DLL Timing, High Speed Data Transmitter, Channel Out-
put Jitter, Typical Building Block Function Performance, Register-to-
Register Performance, and Power Supply Requirements.

Updated Serial Input Data Specifications table.

Updated Transmit table, Serial Rapid I/O Type 2 Electrical and Timing 
Characteristics section.

Pinout Information Updated Signal Description tables.

Updated Pin Information Summary tables and added footnote 1.

February 2009 01.0 — Initial release.

Date Version Section Change Summary


